Texturer un objet 3D
créé au format STL
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openscad est un logiciel libre de modélisation 3D dit «paramétrique» car il
permet de créer des objets 3D non pas a l'aide de la souris comme on le
fait habituellement mais a I'aide d’'un langage de programmation qui est
intégré au logiciel.

Les objets 3D ainsi créés sont associés a des programmes sources et
peuvent étre exportés dans des fichiers texte dotés de l'extension STL
(Stereo-Lithography). Ce format, tres utilisé dans le domaine des
imprimantes 3D, décrit uniguement la forme des objets (sommets
organisés en faces visibles de triangles) et non pas leur texture.

En effet, avec le format STL, les objets 3D ne peuvent pas étre dotés d'une
texture. Il peuvent étre dotés d’une couleur mais celle-ci est uniguement
visible dans openscad. Elle n'est pas visible si on importe le fichier .stl avec
un autre logiciel de modélisation ou de visualisation 3D. En effet, ces
logiciels n'importent en fait que la géomeétrie (c'est a dire la forme) de
I’objet stl et non pas les couleurs éventuellement indiquées dans les fichiers
sources openscad.

Pour pouvoir texturer un objet 3D ayant le format STL, il faut donc
obligatoirement exporter ce fichier dans un autre format, compatible avec
le mappage de texture.

Le mappage de texture peut se définir comme |'établissement d’'une carte
de correspondance entre la surface d'un fichier objet 3D d’'une part et un
fichier image d’autre part.

Pour réaliser cette opération, on peut opérer en suivant les deux étapes
suivantes :

1) Créer un objet STL avec openscad,;
2) Importer et exporter un objet STL avec meshlab

Le fichier obtenu a l'issue de I’étape 2 (fichier exporté avec le format obj),
correspond exactement au fichier stl d’origine (en terme de géométrie)
mais possede en plus une texture définie dans un fichier image png.

openscad meshlab |
création cube.ob)j

—p cube.stl - | fichier obj [ —p cube.mtl
avec texture cube.png

création
fichier stl
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1- Créer un fichier cube.stl avec openscad

= On ouvre openscad.

Le but recherché ici n’est pas de créer une forme 3D compliquée mais
simplement de détailler le déroulement des étapes pré-citées.

= On crée donc simplement un cube de 10 mm de coté.
L’instruction correspondante dans openscad est la suivante.

cube(10) ;
= 0On compile (F5)

= On restitue (F6) puis on exporte dans «cube.stl»

On obtient le fichier cube.stl suivant, contenant la description de 6x2=12
triangles pour 8 sommets.

cube.stl

solid OpenSCAD_Model

facet normal -0 0 1
outer loop
vertex 0 10 10
vertex 10 0 10
vertex 10 10 10
endloop
endfacet

facet normal 0 0 1
outer loop
vertex 10 0 10
vertex 0 10 10
vertex 0 0 10
endloop
endfacet

facet normal 0 0 -1
outer loop
vertex 000
vertex 10 10
vertex 1000
endloop
endfacet

0

facet normal -0 0 -1
outer loop
vertex 1010 0
vertex 000
vertex 0 10 0
endloop
endfacet

facet normal 0 -1 0
outer loop
vertex 000
vertex 10 0 10
vertex 0 0 10
endloop
endfacet

facet normal 0 -1 -0
outer loop
vertex 10 0 10
vertex 000
vertex 1000
endloop
endfacet

facet normal 1 -0 0
outer loop
vertex 10 0 10
vertex 10 10 0
vertex 10 10 10
endloop
endfacet

facet normal 1 0 0
outer loop
vertex 10100
vertex 10 0 10
vertex 1000
endloop
endfacet

facet normal 0 1 -0
outer loop
vertex 10100
vertex 0 10 10
vertex 10 10 10
endloop
endfacet

facet normal 01 0
outer loop
vertex 0 10 10
vertex 10100
vertex 0 10 0
endloop
endfacet

facet normal -1 0 0
outer loop
vertex 000
vertex 0 10 10
vertex 0100
endloop
endfacet

facet normal -1 -0 0
outer loop
vertex 0 10 10
vertex 000
vertex 0 0 10
endloop
endfacet

endsolid OpenSCAD_Model
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2- Manipuler le fichier cube.stl avec meshlab

2.1- Importer le fichier cube.stl dans meshlab

Le logiciel openscad ne permet pas d’exporter les fichiers au format obj.
Pour effectuer cette opération, on utilise ici le logiciel meshlab.

Meshlab est un logiciel open source pour le traitement et I'édition de
maillages triangulaires 3D (triangular meshes).

Il fournit un ensemble d'outils pour éditer, nettoyer, réparer, inspecter,
rendre, texturer et convertir des maillages.

= On ouvre meshlab. On clique File/Import Mesh... puis, dans la boite

de dialogue Import mesh qui s'ouvre on sélectionne le fichier cube.stl
(créé avec openscad) et on clique le bouton Ouvrir.

MeshLab v1.3.2_64bit - [Project_1] Import Mesh

& File Edit Filters Bender View Windows B
" New Empty Project.. Ctri+N 7] & pi Documents |test ‘—

& Open project... Ctr+0

Annuler 'Ouwir

Append project to current
% Save Project Ctrl+S
Close Project ¢
All known formats

Une boite de message Post-Open Processing s’ouvre automatiquement.
On clique le bouton OK. Le cube s’affiche alors automatiquement dans la
fenétre de MeshLab. On peut ajuster sa taille a I'aide de la molette de la
souris.

Post-Open Processing v A X MeshLab _Project_1] v ~ x

& File Edit Filters
+ |Unify Duplicated Vertices ¢

'_'h'l o E!j 33
Reset Cancel 0K
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2.2- Attribuer une texture au cube dans meshlab

= On clique Filters/Texture/Parametrization Trivial Per-triangle
& File Edit Filters BRender View Window
™ ﬁ i Apply filter Per Vertex Color Fur
_ Show current filter script

Sampling
Texture Convert PerVertex UV into PerWedge
Camera Convert PerWedge UV into PerVertex
Parameterization + texturing from reg

Parameterization from registered rasi

Parametrization: Flat Plane

Farametrization: Trivial Per-Triangle

& File Edit Filters Render View Windows Tools Help Sl
™ E@ i Apply filter Per Vertex Color Function Ctrl+L E |

Show current filter script

Selection >
Cleaning and Repairing >
Create New Mesh Layer >
Remeshing, Simplification and Reconstruction >
Polygonal and Quad Mesh >
Color Creation and Processing >
Smoothing, Fairing and Deformation >
Quality Measure and Computations >
Normals, Curvatures and Orientation >
Mesh Layer »
Raster Layer >
Range Map >
Point Set >

Sampling
Texture Convert PerVertex UV into PerWedge UV
Convert PerWedge UV into PerVertex UV

Parameterization + texturing from registered rasters

Camera

Parameterization from registered rasters
Parametrization: Flat Plane

Parametrization: Trivial Per-Triangle

Parametrization: Voronoi Atlas

l " Project active rasters color to cur
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= Dans la boite de dialogue qui s’ouvre, on choisit Basic puis on clique le
bouton Apply puis on referme la boite de dialogue en cliquant le bouton de
fermeture contenant une croix, situé en haut a droite

FParametrization: Trivial Per-Triangle 3]

Builds a trivial triangle-by-triangle parametrization.
Two methods are provided the first maps maps all
triangles into equal sized triangles, while the second
one adapt the size of the triangles in texture space
to their original size.

Quads per line 0
Texture Dimensicn (px) | 1024

Inter-Triangle border (px) o

Method —) Basic .
Preview
Default Help
Close — Apply

= On clique Filters/Texture/Set Texture

MeshlLab v1.3.2_64bit - [Project_1]
File Edit Filters BRender View Windows Tools Help
™y % i Apply filter Parametrization: Trivial Per-Triangle DtrI+L| | I @ l]

Show current filter script

Sampling

Texture Convert PerVertex UV int
Convert PerWedge UV inf

Parameterization + textu

Camera

Project active rasters col

Select Vertex Texture Ses

Texture to Vertex Color (1

Transfer Vertex Attributes

Vertex Color to Texture
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= Dans la boite de dialogue qui s’ouvre, on clique le bouton Apply puis on
referme la boite de dialogue en cliquant le bouton de fermeture contenant
une croix, situé en haut a droite.

Set Texture (3¢
Set a texture associated with current mesh T
parametrization.

If the texture provided exists it will be simply
associated to the current mesh else a dummy
texture will be created and saved in the same
directory.

Texture file cube.png

Texture Dimension (px) 1074

Default Help

Close — Apply

= On clique Edit/Texture Parametrization Tool

MeshLah v1.3.2_64hit - [Project_1]
@ File Edit Filters BRender View Windows Tools Help
B (b it
@ Align
B Arc3D Importer
® Fill Hole

+~ Manipulators Tool

& Measuring Tool

4 Z-painting

B PickPoints

“£ Select Vertex Clusters

“% Select Vertexes on a Plane

& Quality Mapper

" Select Vertexes

& Select Faces in a rectagular region

#! Select Connected Components in a region
we TExtUre Parametrization Tool

@ Get Info
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= Dans la boite de dialogue qui s’ouvre, on clique le bouton Apply puis on
referme la boite de dialogue en cliquant le bouton de fermeture contenant
une croix, situé en haut a droite.

B ®

A

cube.png

Action selection

h__ Ly o x & *‘,._ R

Optimization
Remap Change Texture
Clamp  Modulus cube.png Browse

Smooth texture coordinates
e Whole model Selected faces [teration 1 °  Apply

Résumé des opérations

= 1) Filters/Texture/Parametrization Trivial Per-triangle
w» 2) Filters/Texture/Set Texture
w 3) Edit/Texture Parametrization Tool
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2.3- Exporter le cube texturé au format obj

= On clique File/ Export Mesh As...

MeshLab v1.3.2_64bit - [Project_1]
& [File Edit
 New Empty Project... Ctri+N )

& Open project... Ctrl+0

Filters Bender View Windows

Append project to current...
¥ Save Project Ctrl+S

Close Project

& |mport Mesh... Ctrl+l
¥ Export Mesh... Ctrl+E
<+ Export Mesh As...

e R

= Dans la boite de dialogue qui s’ouvre, on sélectionne

« le format Wavefront Object (.obj) ;
« le nom du fichier (ici cube.obj) ;
- le répertoire de destination (ici, home/pi/Documents/test)

= puis on clique le bouton Save

Save "cubestl" Layer
Look in: ™ /home/pi/Documents/test -0 Q0 0 @. H R
& Computer ?
M pi ¢
File name: cube.obj {— Save
Files of type: éﬁlias Wavefront Object ( *.obj) ‘— . Cancel

Une boite de dialogue s’affiche alors automatiquement, indiquant que la
création de la texture est bien prise en compte.
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Les indications Wedge (coin) TexCoord et Texture Name montrent que
meshlab a bien pris en compte la création d’'un texture associée a |'objet
3D exporté au format obj.

= On clique le bouton OK

Choose Saving Options for: 'cube.stl’

Vert Face Wedge Texture Name
cube.png

v TexCoord

« [Normal

o All
Help —} OK Cancel
MNone 'olygona

= On se rend dans le répertoire home/pi/Documents/test, a |'aide de
I’explorateur de fichier.

On y trouve le fichier cube.stl d’origine (créé avec openscad) ainsi que les
trois fichiers suivants créés par meshlab :

» cube.obj: fichier contenant la description de la géométrie du cube ;
» cube.obj.mtl: fichier contenant la description des matériaux du cube ;
* cube. png : fichier ontenant I'image de la texture appliquée au cube.

Fichier Edition Voir Sort Allera Outils

il g | o= EE ®| < I | /home/pi/Documents/test
# Dossier personnel - =
: ; ; : = = L
{2 Racine du systeme de fichiers G| - - -
cube.obj cubeobjmtl cubepng cube st

& EMTEC C410

i Documents
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cube.obj

#H##

#

# OBJ File Generated by Meshlab
#

#H##

# Object cube.obj

#

# Vertices: 8

# Faces: 12

#

#H##

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —-1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000O0

# 8 vertices, 0 vertices normals

usemtl material_ O

vt 0.165976 0.999023
vt 0.000977 0.834024
vt 0.165976 0.834024

f 1/1/1 3/2/3 4/3/4

vt 0.167357 0.667643
vt 0.332357 0.832643
vt 0.167357 0.832643

f 3/4/3 1/5/1 2/6/2

vt 0.499309 0.999023
vt 0.334310 0.834024
vt 0.499309 0.834024

f 8/7/8 5/8/5 6/9/6

vt 0.500691 0.667643
vt 0.665690 0.832643
vt 0.500691 0.832643

f 5/10/5 8/11/8 7/12/7
vt 0.832643 0.999023
vt 0.667643 0.834024
vt 0.832643 0.834024

f 8/13/8 3/14/3 2/15/2
vt 0.834024 0.667643
vt 0.999023 0.832643
vt 0.834024 0.832643

f 3/16/3 8/17/8 6/18/6
vt 0.165976 0.665690
vt 0.000977 0.500691
vt 0.165976 0.500691

f 3/19/3 5/20/5 4/21/4
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vt 0.167357 0.334310
vt 0.332357 0.499309
vt 0.167357 0.499309

£ 5/22/5 3/23/3 6/24/6
vt 0.499309 0.665690
vt 0.334310 0.500691
vt 0.499309 0.500691

£ 5/25/5 1/26/1 4/27/4
vt 0.500691 0.334310
vt 0.665690 0.499309
vt 0.500691 0.499309

£ 1/28/1 5/29/5 7/30/7
vt 0.832643 0.665690
vt 0.667643 0.500691
vt 0.832643 0.500691

f 8/31/8 1/32/1 7/33/7
vt 0.834024 0.334310
vt 0.999023 0.499309
vt 0.834024 0.499309

f 1/34/1 8/35/8 2/36/2
# 12 faces, 36 coords texture
# End of File

cube.obj.mtl

#

# Wavefront material file

# Converted by Meshlab Group
#

newmtl material_ O

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube.png

cube.png

Fichier Edition Vue Image Couleurs Configuration Aide
Nouveau _E Ouvrir.. J[E Enregistrer

@4

1024 x 1024 32 bpp 20 %
O PP o

Le fichier cube.png est un fichier maquette (dummy file) créé automa-
tiquement par meshlab. Il peut étre modifié, a I'aide de Gimp ou de kolour-
paint par exemple, pour contenir une image de texture de notre choix.
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2.4 Ouvrir le fichier cube.obj avec meshlab

= On ouvre meshlab et on clique File/Import/ cube.obj

Le cube s’affiche alors automatiquement dans la fenétre de meshlab re-
couvert de la texture cube.png qui avait été créée par défaut.

MeshLabvl..t-[Project 1] ~ ~ x
& File Edit Filters Render » B8 ®

N -0 X-

On peut modifier cette texture, a I'aide de Gimp ou de Kolourpaint par
exemple. On peut par exemple créer une image en forme de tresse marron
que I'on enregistre dans le fichier cube.pnag.

cube.png — KolourPaint
Fichier Editon Vue Image Couleurs Configuration Aide
= Nouveau _E Ouvrir.. [ Enregistrer

s
f} | |
5.7

Al
e

P &
i
s 0
@]
RO

Zoom |25 % - Zoom 200% |«
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= On ouvre alors a nouveau le fichier cube.obj avec meshlab et on
vérifie que le cube s’affiche désormais avec la texture modifiée.

& File Edit Filters Render View Windows Tools »E & &

NFecoR- O 5 X~

MeshlLab v1.3.2_64bit - [Project_1] v oA X

= Pour s’assurer que la texture du cube s’affiche correctement, on clique
Filters/ColorCreationandProcessing/ PerVertexColor Function

File Edit Filters Bender View Windows Tools Help Ambient Occlusion - Per Vertex

™ % i Apply filter Per Vertex Color Function Colar noise
I Show current filter script Colarize by border distance

Colorize by distance from a give

Selection >
o ., izel uall
Cleaning and Repairing ,  Colorize by face Quality
[ Vert jali
Create New Mesh Layer ,  Colorize by vertex Quality

| Irvat 5
Remeshing, Simplification and Reconstruction » COloerE EHOVBLNE [_APJSJ
Polygonal and Quad Mesh EtloilzeicaniatuE{AIMIS)

e epthc [

and Processing Depth complexity
T ; Discrete Curvatures
Smoothing, Fairing and Deformation

Disk Vertex Coloring

Quality Measure and Computations >
. ! Equalize Vertex Color
Mormals, Curvatures and Orientation > d -
Mesh Layer ,  PerFace Color Function
i L
Raster Layer ; Per Face Quality according to Tri

Per Vertex Color Fu nction

Range Map
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Dans la boite de dialogue qui s’ouvre, on place les valeurs 255

dans les zones r, g, b et a puis on clique le bouton Apply puis on
referme la boite de dialogue en cliquant le bouton de fermeture contenant
une croix, situé en haut a droite.

Per Face Color Function E3]

Color function using muparser lib to generate new RGE color for
every face

Insert three function each one for red, green and biue channe!
respectively

Its possibile to use per-face variables like attributes associated to the
three vertex of every face.

x0,y0,z0 for first vertex; x1,v1,z1 for second vertex, x2y2 z2 for third
vertex.

and also nx0,ny0,nz0 nx1,nyl,nzl etc. for normals and r0,g0,b0 for
color.q0,q1,q92 for gquality wiul, wiv0, witul, wivi wtuz, wiv? (per
wedge tex coord ).

funcr = 255 ‘_
func g = 255 ‘_
func b = 755 ‘—
func alpha = o555 ‘_
Preview
Default Help
Close = Apply

On décoche la case View/Trackball/ Show Trackball afin de ne pas
afficher la boule de commande de rotation (trackball) autour du cube.
Remarque : le mappage de texture effectué automatiquement par
meshlab peut étre modifié ou ajusté (cf paragraphe 4)
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3-Tester des filtrages de cube.stl avec meshlab

3.1) Sans filtrage

» File/Import Mesh.../cube.stl
» File/Export Mesh As.../cube.obj

On voit que dans le cadre d'une importation de cube.stl suivie aussitot
d’'une exportation dans le format obj (sans filtrage préalable), meshlab
crée des informations uniquement sur les sommets du cube (Vertices) et
non pas sur les faces ni sur les coins (Wedge). Dans ce cas, meshlab crée
uniquement un fichier cube.obj et ne crée pas de fichier cube.obj.mtl ni
de fichier cube.png.

/home/pi/Documents/test
Vert Face Wedge
cube.obj cube.stl
v MNormal

Dans le fichier cube.obj, on trouve la description de :
* 8 sommets (v),

* 8 normales de sommets (vn)

» 12 faces (f).

Les 12 faces (f) sont en fait ici les 2x6 mailles triangulaires qui constituent
les 6 faces du cube

cube.obj

#HH##

#

# OBJ File Generated by Meshlab
#

#HH##

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH##

vn 0.000000 0.000000 0.785398
v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
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v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —-1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000O0

# 8 vertices, 0 vertices normals

1//1 3//3 4//4
3//3 1//1 2//2
8//8 5//5 6//6
5//5 8//8 7//7
8//8 3//3 2//2
3//3 8//8 6//6
3//3 5//5 4//4
5//5 3//3 6//6
5//5 1//1 4//4
1//1 5//5 7//7
8//8 1//1 7//7
1//1 8//8 2//2

12 faces, 0 coords texture

+= H= Hh Hh Hh Hh Fh Fh Hh Hh Hh Hh Fh Eh

End of File

3.2) Filtrage Parametrization Trivial Per-Triangle /Basic

» File/Import Mesh.../cube.stl
» Filters/Texture/Parametrization Trivial Per-Triangle /Basic
» File/Export Mesh As.../cube.obj

On voit que dans le cas d'un filtrage de type paramétrisation par triangle
basique, avant I'export, meslab crée des coordonnées de textures.

| Ose 10 | [ fa
' /home/pi/Documents/test
Vert Face Wedge
= o -
cube.obj cubeobp.mtl cubestl
v TexCoord
v Normal
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Dans ce cas, meshlab crée également un fichier cube.obj.mtl mais
cependant ne crée pas de fichier cube.png.

Dans le fichier cube.obj, on trouve un renvoi vers le fichier cube.obj.mtl
plus la description de :

8 sommets (v),

8 normales de sommets (vn)

12 faces (f)

36 coordonnées de textures (3 cordonnées x,y,z par face)

cube.obj

#HH#

#

# OBJ File Generated by Meshlab
#

#HH#

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH#

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —-1.570796 0.000000 0.000000
v 0.000000 10.000000 0.00000O0
vn —-0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000

# 8 vertices, 0 vertices normals

usemt]l material O

vt 0.000977 0.669024
vt 0.330976 0.999023
vt 0.000977 0.999023
£f 1/1/1 3/2/3 4/3/4

vt 0.332357 0.997642
vt 0.002358 0.667643
vt 0.332357 0.667643
f 3/4/3 1/5/1 2/6/2

vt 0.334310 0.669024
vt 0.664309 0.999023
vt 0.334310 0.999023
f 8/7/8 5/8/5 6/9/6

vt 0.665690 0.997642
vt 0.335691 0.667643
vt 0.665690 0.667643
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£ 5/10/5 8/11/8 7/12/7
vt 0.667643 0.669024
vt 0.997642 0.999023
vt 0.667643 0.999023

f 8/13/8 3/14/3 2/15/2
vt 0.999023 0.997642
vt 0.669024 0.667643
vt 0.999023 0.667643

f 3/16/3 8/17/8 6/18/6
vt 0.000977 0.335691
vt 0.330976 0.665690
vt 0.000977 0.665690

£f 3/19/3 5/20/5 4/21/4
vt 0.332357 0.664309
vt 0.002358 0.334310
vt 0.332357 0.334310

£ 5/22/5 3/23/3 6/24/6
vt 0.334310 0.335691
vt 0.664309 0.665690
vt 0.334310 0.665690

£ 5/25/5 1/26/1 4/27/4
vt 0.665690 0.664309
vt 0.335691 0.334310
vt 0.665690 0.334310

£ 1/28/1 5/29/5 7/30/7
vt 0.667643 0.335691
vt 0.997642 0.665690
vt 0.667643 0.665690

f 8/31/8 1/32/1 7/33/7
vt 0.999023 0.664309
vt 0.669024 0.334310
vt 0.999023 0.334310

f 1/34/1 8/35/8 2/36/2
# 12 faces, 36 coords texture
# End of File

Le fichier cube.obj.mtl décrit le matériel (lumiere, couleurs, texture)
utilisé. Dans le cas présent, il ne contient que des informations de base,
correspondant a un éclairage et a une couleur standards du cube.

cube.obj.mtl
#
# Wavefront material file

# Converted by Meshlab Group
#

newmtl material 0

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

Remarque

Dans notre exemple, si on effectue le traitement Parametrization Trivial
Per-Triangle /Space optimizing au lieu du traitement Parametrization
Trivial Per-Triangle /Basic, on obtient le méme contenu pour les fichiers
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cube.obj et cube.obj.mtl. Cela n’est pas étonnant car le cube est un objet
3D basique

3.3) Filtrage Parametrization : Flat Plane

» File/Import Mesh.../cube.stl
» Filters/Texture/Parametrization : Flat Plane
» File/Export Mesh As.../cube.obj

On voit que dans le cas d’'une paramétrisation de type Flat Plane, avant
I’export, meslab crée des coordonnées de textures.

' = ( f JE ; = .
/home/pi/Documents/test
Vert Face Wedge
cubeob] cubeobpmtl cubestl
v TexCoord
v MNormal

Dans ce cas, meslab crée également un fichier cube.obj.mtl sans créer de
fichier cube.png

Dans le fichier cube.obj, on trouve toujours un renvoi vers le fichier
cube.obj.mtl mais cette fois-ci on a la description de :

* 8 sommets (v),

* 8 normales de sommets (vn)

» 12 faces (f) et, cette fois-ci, a la différence de la fois précédente,
* 4 coordonnées de textures seulement au lieu de 36.

cube.obj

#HH#

#

# OBJ File Generated by Meshlab
#

#HH#

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH#

mtllib ./cube.obj.mtl
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vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —-1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000O0

# 8 vertices, 0 vertices normals

usemtl material_ O

vt 0.000000 1.000000
vt 1.000000 0.000000
vt 1.000000 1.000000
£f 1/1/1 3/2/3 4/3/4
vt 0.000000 0.000000
3/2/3 1/1/1 2/4/2
8/4/8 5/3/5 6/2/6
5/3/5 8/4/8 7/1/7
8/4/8 3/2/3 2/4/2
3/2/3 8/4/8 6/2/6
3/2/3 5/3/5 4/3/4
5/3/5 3/2/3 6/2/6
5/3/5 1/1/1 4/3/4
1/1/1 5/3/5 7/1/7
8/4/8 1/1/1 7/1/7
1/1/1 8/4/8 2/4/2
12 faces, 4 coords texture
End of File

H= = th Hh Hh Hh Fh Hh Hh Fh Hh Fh Eh

Le contenu du fichier cube.obj.mtl reste inchangé

cube.obj.mtl
#
# Wavefront material file

# Converted by Meshlab Group
#

newmtl material_ O

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000
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4- Texturer cube.obj a la main

4.1 Texturer une seule face

En partant des fichiers cube.obj et cube.obj.mtl précédents, créés par
meshlab, on peut texturer I'objet 3D de facon manuelle en procédant de la
facon suivante.

= On reprend le fichier cube.obj précédent dans lequel on modifie la
partie usemtl material_0 comme indiqué ci-apres

cube.obj

#HH#

#

# OBJ File Generated by Meshlab
#

#HH#

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH#

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.00000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000

# 8 vertices, 0 vertices normals

usemtl material_O
vt 0.000000 1.000000
vt 0.000000 0.000000
vt 1.000000 0.000000
vt 1.000000 1.000000
1/1/1 3/3/3 4/4/4
3/3/3 1/1/1 2/2/2
8//8 5//5 6//6
5//5 8//8 7//7
8//8 3//3 2//2
3//3 8//8 6//6
3//3 5//5 4//4
5//5 3//3 6//6
5//5 1//1 4//4
1//1 5//5 7//7
8//8 1//1 1//7

Hh Fh Hh Hh Fh Hh Fh Fh Eh Eh D
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£ 1//1 8//8 2//2
# 12 faces, 4 coords texture
# End of File

= On crée, a l'aide gimp ou de kolourpaint, un fichier image cube.png
destiné a servir de texture pour le cube. Par exemple le fichier cube.png de
taille 1024x1024 pixels suivant:

cube.png — KolourPaint

Fichier Edition Vue Image Couleurs Confi

= Nouveau E Ouvrir.. [ Enregistrer

-

= On ajoute I'instruction map_Kd cube.png a la fin du fichier cube.obj.mtl

cube.obj.mtl

#

# Wavefront material file

# Converted by Meshlab Group
#

newmtl material_ O

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube.png

En ouvrant cube.obj avec meshlab on constate qu’avec le mappage de
texture réalisé, la face avant du cube est texturée avec I'image cube.png.

Les autres faces (celles indiquées v//vn, au lieu de v/vt/vn) ne sont pas
texturées.

23/31



4.2 Texturer les 6 faces du cube a lI'identique

Pour manipuler la partie contenant les coordonnées de texture, on peut
utiliser les schémas suivants qui illustrent I'ordre des sommets (1 a 8) et
des coordonnées de textures (1 a 4) définis par meshlab dans le fichier
cube.obj.

Yy N
? ‘5 1z =7 0.000000 10.000000 10Q.000000
2 W 0.000000 0.000000 10.000000
3: v 10.000000 0.000000 10.000000
d: v 10.000000 10.000000 10.000000
1 4 5: v 10.000000 10.000000 O.000000
» - » &: v 10.000000 0.000000 O.000000
! T W 0.000000 10.000000 O.000000
: 8: w 0.000000 0.000000 O.000000
8. 6
*------- F :} X
z
V/ Y N
1 4
> - 1: wt O0.000000 1.000000
2 3 Ze vt O0.000000 0O.000000
3: wvt 1.000000 0O.000000
d: wt 1.000000 1.000000
2 3 :> X

D’'ou le codage des faces suivant, en se placant en face de la face
considérée

#face avant

f 1/1/1 3/3/3 4/4/4
£f 3/3/3 1/1/1 2/2/2
#face arriére

f 8/3/8 5/1/5 6/2/6
£f 5/1/5 8/3/8 7/4/7
#face du bas

f 8/4/8 3/2/3 2/3/2
f 3/2/3 8/4/8 6/1/6
#face de droite

f 3/2/3 5/4/5 4/1/4
£f 5/4/5 3/2/3 6/3/6
#face de dessus

f 5/4/5 1/2/1 4/3/4
£ 1/2/1 5/4/5 7/1/7
#face de gauche

f 8/2/8 1/4/1 7/1/7
f 1/4/1 8/2/8 2/3/2
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En ouvrant cube;obj avec meshlab, on onstate que chaque face du cube est
texturée avec I'image contenue dans le fichier cube.png

Cube.obj

#HH#

#

# OBJ File Generated by Meshlab
#

#HH#

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH#

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000

# 8 vertices, 0 vertices normals

usemtl material O

vt 0.000000 1.000000
vt 0.000000 0.000000
vt 1.000000 0.000000
vt 1.000000 1.000000
#face avant

£ 1/1/1 3/3/3 4/4/4
£ 3/3/3 1/1/1 2/2/2
#face arriére

f 8/3/8 5/1/5 6/2/6
£ 5/1/5 8/3/8 7/4/7
#face du bas

f 8/4/8 3/2/3 2/3/2
f 3/2/3 8/4/8 6/1/6
#face de droite

f 3/2/3 5/4/5 4/1/4
f 5/4/5 3/2/3 6/3/6
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#face de dessus

f 5/4/5 1/2/1 4/3/4

£ 1/2/1 5/4/5 7/1/7

#face de gauche

£ 8/2/8 1/4/1 7/1/7

£f 1/4/1 8/2/8 2/3/2

# 12 faces, 4 coords texture
# End of File

cube.obj.mtl

#

# Wavefront material file

# Converted by Meshlab Group

#

newmtl material_0

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube.png

4.3 Texturer les 6 faces du cube avec 6 textures

On commence par créer 6 textures qu’on appelle cube0l.png a cube06.png
par exemple (une texture différente pour chaque face du cube).

cube01.png cube02.png cube03.png cube04.png cube05.png cube06.png

On modifie le fichier cube.obj.mtl de facon a prendre en compte ces 6
textures

cube.obj.mtl

#

# Wavefront material file

# Converted by Meshlab Group
#

newmtl material_ 1

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cubelOl.png

newmtl material_ 2

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000

Tr 1.000000
illum 2
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Ns 0.000000
map_Kd cubel02.png

newmtl material_ 3

Ka 0.200000 0.200000
Kd 1.000000 1.000000
Ks 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube03.png

.200000
.000000
.000000

o

newmtl material_ 4

Ka 0.200000 0.200000
Kd 1.000000 1.000000
Ks 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube04.png

.200000
.000000
.000000

o

newmtl material_ 5

Ka 0.200000 0.200000
Kd 1.000000 1.000000
Ks 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube05.png

.200000
.000000
.000000

o

newmtl material_ 6

Ka 0.200000 0.200000
Kd 1.000000 1.000000
Ks 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cubel06.png

.200000
.000000
.000000

o

Il suffit alors d’insérer I'instruction usemtl material_i (avec i allant de 1 a6 )
avant chaque face, dans le fichier précédent, pour obtenir le résultat
souhaité.

#HH#

#

# OBJ File Generated by Meshlab
#

#HH#

# Object cube.ob]

#

# Vertices: 8

# Faces: 12

#

#HH#

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398
v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000
v 10.000000 0.000000 10.000000
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vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn -1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn -0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000

# 8 vertices, 0 vertices normals

vt 0.000000 1.000000
vt 0.000000 0.000000
vt 1.000000 0.000000
vt 1.000000 1.000000

#face avant

usemtl material_ 1

f 1/1/1 3/3/3 4/4/4
f 3/3/3 1/1/1 2/2/2

#face arriére
usemt]l material_ 2

f 8/3/8 5/1/5 6/2/6
£f 5/1/5 8/3/8 7/4/7

#face du bas

usemt]l material_3

f 8/4/8 3/2/3 2/3/2
f 3/2/3 8/4/8 6/1/6

#face de droite
usemtl material 4

f 3/2/3 5/4/5 4/1/4
f 5/4/5 3/2/3 6/3/6

#face de dessus
usemtl material_ 5

f 5/4/5 1/2/1 4/3/4
£f 1/2/1 5/4/5 7/1/7

#face de gauche

usemt]l material_6

£ 8/2/8 1/4/1 7/1/7

f 1/4/1 8/2/8 2/3/2

# 12 faces, 4 coords texture

# End of File

On ouvre cube.obj avec meshlab et on vérifie que le résultat obtenu est
correct.
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4.4 Texturer les 6 faces avec une texture globale

On crée une texture globale, a l'aide de Gimp ou de kolourpaint par
exemple, qu’on enregistre dans le fichier cube01a06.png.

Si on dimensionne la texture de chaque face du cube a 512x512 pixels, la
texture globale fait 1536x1024 pixels.

Dans ce cas, on a les 12 couples vt (x,y) suivants de coordonnées de
texture. On en déduit les faces v/vt/vn du cube avec vt et vn restant
inchangés par rapport au fichier obj initial généré par meshlab.

i N
1 2 3 4 5 +5
1
L . -4
8 6 ?f
9 10 11 12 $--onoe- =
v d
zonn1j15$ﬁ =
32b

1536 x 1024 PP 2 ! i 3
01: vt 0.000000 1.000000 #face avant [1]
02: vt 0.333333 1.000000 f 1/1/1 3/6/3 4/2/4
03: vt 0.666666 1.000000 £ 3/6/3 1/1/1 2/5/2
04: vt 1.000000 1.000000 4face arriere [2]
055 vt 0.000000 0.500000 1 e/7/8 5/575 6/6/6
06: vt 0.333333 0.500000 t ciave ararE 73T
07: vt 0.666666 0.500000
08: vt 1.000000 0.500000 #face du bas [3]
09: vt 0.000000 0.000000 f 8/7/8 3/4/3 2/3/2
10: vt 0.333333 0.000000 f 3/4/3 8/7/8 6/8/6
11: vt 0.666666 0.000000
12: vt 1.000000 0.000000 #face de droite [4]

f 3/9/3 5/6/5 4/5/4
f 5/6/5 3/9/3 6/10/6

#face de dessus [5]
f 5/7/5 1/10/1 4/11/4
£ 1/10/1 5/7/5 7/6/7

#face de gauche [6]

f 8/11/8 1/8/1 7/7/7

f 1/8/1 8/11/8 2/12/2

# 12 faces, 12 coords texture
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Les fichiers cube.obj et cube.obj.mtl résultant sont les suivants.

cube.obj

#H##

#

# OBJ File Generated by Meshlab
#

#H##

# Object cube.obj

#

# Vertices: 8

# Faces: 12

#

#H##

mtllib ./cube.obj.mtl

vn 0.000000 0.000000 0.785398

v 0.000000 10.000000 10.000000
vn 0.000000 -1.570796 0.000000
v 0.000000 0.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 0.000000 10.000000
vn 1.570796 0.000000 0.000000

v 10.000000 10.000000 10.000000
vn 0.785398 0.000000 0.000000

v 10.000000 10.000000 0.000000
vn 1.570796 0.000000 0.000000

v 10.000000 0.000000 0.000000
vn —-1.570796 0.000000 0.000000
v 0.000000 10.000000 0.000000
vn —0.785398 0.000000 0.000000
v 0.000000 0.000000 0.000000O0

# 8 vertices, 0 vertices normals

usemtl material_1

vt 0.000000 1.000000
vt 0.333333 1.000000
vt 0.666666 1.000000
vt 1.000000 1.000000
vt 0.000000 0.500000
vt 0.333333 0.500000
vt 0.666666 0.500000
vt 1.000000 0.500000
vt 0.000000 0.000000
vt 0.333333 0.000000
vt 0.666666 0.000000
vt 1.000000 0.000000

#face avant [1]
£ 1/1/1 3/6/3 4/2/4
£f 3/6/3 1/1/1 2/5/2

#face arriére [2]
f 8/7/8 5/2/5 6/6/6
£ 5/2/5 8/7/8 7/3/7

#face du bas [3]

£ 8/7/8 3/4/3 2/3/2
£ 3/4/3 8/7/8 6/8/6
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#face de droite [4]
f 3/9/3 5/6/5 4/5/4
£f 5/6/5 3/9/3 6/10/6

#face de dessus [5]
£ 5/7/5 1/10/1 4/11/4
£ 1/10/1 5/7/5 7/6/7

#face de gauche [6]

f 8/11/8 1/8/1 7/7/7

f 1/8/1 8/11/8 2/12/2

# 12 faces, 12 coords texture
# End of File

cube.obj.mtl

#

# Wavefront material file

# Converted by Meshlab Group
#

newmtl material_1

Ka 0.200000 0.200000 0.200000
Kd 1.000000 1.000000 1.000000
Ks 1.000000 1.000000 1.000000
Tr 1.000000

illum 2

Ns 0.000000

map_Kd cube01a06.png

En ouvrant cube.obj avec meshlab on obtient le méme résultat qu’'avec
I'exemple précédent qui utilisait un fichier png différent pour chaque face
du cube.

ot %

31/31



